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1 Overview

1.1 Introduction

SDI LPD is a 32-bit print daemon that accepts print jobs from a remote computer and prints them on a Windows
printer. SDI LPD runs on Windows 11, 10, 8, 7, XP  and Windows Server 2022, 2019, 2016, 2012, 2008, 2003
and 2000. Any computer operating system that supports LPR (VSE, VM, MVS, OS/390, OS/400 and UNIX) can
send print jobs via TCP/IP to SDI LPD. 

The diagram below the illustrates the print job flow:
 
 

 

See Also:
 

Features
Getting Started

1.2 Features

Protocol Conforms to the standard Line Printer Daemon Protocol (LPD). (RFC 1179).
 

Printers Supports any Windows local and network printers.
 

Printer Management Pause, resume and delete jobs. Hold jobs in the queue instead of printing.
Print jobs to a file instead of a printer.

 

Page Management Complete control over the page format. Print in portrait or landscape
orientation. Set page margins. Control the number of rows and columns per
page. Scale the font width to fit the page. Suppress or append form feeds.
Send RAW data to the printer.

 

Default Queue (New!) Define a default queue. Any jobs with an unknown queue name are
automatically routed to the default queue.

 

EBCDIC to ASCII Support EBCDIC to ASCII character translation. Numerous code pages are
provided.

 

LF to CR/LF conversion Support the conversion of Line Feeds to Carriage Return and Line Feeds.
(Required for converting UNIX files to Windows text files.)

 

SCS Supports SNA Character Strings (SCS) used on IBM zSeries (mainframe)
and iSeries (AS/400) systems.

 

Banner Page Supports banner pages. 
 

System Tray Can run in the system tray.
 

Fonts User selectable fonts.
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1.3 System Requirements

· Microsoft Windows  11, 10, 8, 7, XP and Windows Server 2022, 2019, 2016, 2012, 2008, 2003 and 2000.
 

· 500 KB of available hard disk space.
 

· VGA, 16-color or higher resolution monitor.
 

· TCP/IP.
 

· A connection to the Internet or an intranet.

1.4 Restrictions

SDI LPD does not support the following:
 

· Mail when printed
 

· Plot CIF (CalTech Intermediate Form) files
 

· DVI files
 

· Postscript files
 

· Raster files
 

1.5 Evaluation and License Agreements

Evaluation

SDI LPD is distributed in an evaluation version for a 30 day evaluation. After the 30-day evaluation period, you
must register the product with SDI if you wish to continue using the product. See the Registration Instructions
for information on how to register SDI LPD.

License Agreement

By registering for and/or ordering  SDI LPD, by whatever means, you agree to be bound by the terms and
conditions of the  Licensing Agreement.

1.6 Pricing

The per copy registration prices are found on the following web page:

SDI LPD Prices

Please refer to the License Agreement and the Maintenance and Technical Support Agreements. for SDI's
exclusive terms and conditions of use and sale. 

1.7 Registration Instructions

An evaluation version of SDI LPD may be downloaded from the SDI web site at http://www.sdisw.com.

The evaluation version of SDI LPD will run for 30 days. After 30 days, SDI LPD will no longer operate. To convert
your evaluation version into a licensed version you must register the product with SDI and receive a license
code. 

http://sdisw.com/license.htm
http://sdisw.com/LPD/prices.htm
http://sdisw.com/license.htm
http://sdisw.com/maintenance.htm
http://www.sdisw.com
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Registering SDI LPD Via the Internet

The fastest and easiest way to order SDI LPD is via the internet using the SDI Secure Order System. All you
need is a web browser and a valid credit card. (SDI accepts Visa, MasterCard, American Express, Eurocard and
Optima.)

To connect to our secure order page, open the Help menu and click Purchase Online or click on the following
link: http://www.sdisw.com/lpd/order.htm

Complete the online form and download your licensed version of SDI LPD.

Sending Registration Information to SDI

SDI LPD may be registered by filling out the Registration Form and sending it and your payment to SDI. Once
you have registered, SDI will send you a copy of the licensed version via e-mail. Full instructions for completing
the registration form may be found below.

Filling Out the Registration Form

 

1. Fill out the customer information section.
 

2. Complete the delivery information.
 

a) Make sure your e-mail address is included on the registration form. 
 

b) Write the number of copies of SDI LPD you wish to license in the space provided. Compute the
total license maintenance fees using the SDI LPD Prices web page and write it in the space
provided.

 

c) Add the manual order surcharge fee of $35.00 if the order is under $300. 
 

d) Add the license fee, maintenance fee and surcharge fee to compute the total cost.
  

3. Sign the form.
 

4. Send the completed form and your payment to the address below.
 

Mailing Addresses:

SDI USA, Inc. 

P. O. Box 5801 

San Mateo, CA 94402 

Telephone:      650 572 1200

E-mail: admin@sdisw.com

Make your payment in one of the following ways:
 

a) Check: Send the registration form and your check in United States dollars to the mailing
address listed above.

 

b) Purchase order: Corporate Purchase Orders will be accepted on orders of 15 or more
copies. Send or e-mail the registration form and your purchase order to the mailing address or
e-mail address listed above. The purchase order is due for settlement within 30 days of
registration.

 

c) Wire Transfer: Clients wishing to pay by wire or electronic funds transfer should contact SDI
for instructions. Please e-mail admin@sdisw.com with your relevant details, and we will be
happy to provide you with the information. Invoiced accounts will have our bank details on the
face of the sales invoice after your order has been processed.

 

http://www.sdisw.com/lpd/order.htm
http://sdisw.com/lpd/prices.htm
mailto:admin@sdisw.com
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1.8 Registration Form

To print this form, click on the Print button on the button bar at the top of the page or select Print Topic... in the
File menu. Review the Registration Instructions for information on how to complete this form.

Note that orders submitted via this order form are processed manually.  There is a small surcharge (US$35) for
orders less than $300 in value submitted by this order form.  You can avoid the surcharge by ordering via credit
card or increasing your order to at least $300.

Name:                                                   Date:                        

Company:                                                                                   

Address:                                                                          

City, State, Zip:                                                                          

Country:                                                                          

Phone:                                                                          

E-mail address:                                                                          

Product Information

SDI LPD for Windows

_______ Quantity

_______ Unit Price Price per copy.  See the SDI LPD  price chart

_______ Subtotal Unit price * quantity

_______ Maintenance Plan 15% of purchase price ($100.00 minimum)

_______ Processing Fee $35.00 on orders < $300.00 

_______ Total Price

Payment method:

___ Purchase Order: purchase order number: ______________________

___ Wire Transfer: wire transfer reference number: ______________________

___ Check Enclosed: enclose check with this form
 

 

BY SIGNING THIS FORM YOU CONFIRM THAT YOU HAVE READ AND AGREE TO ALL TERMS AND
CONDITIONS OF USE IN THE SDI LPD License Agreement and Maintenance and Technical Support
Agreements.

Signature:  _____________________________________________________

SDI USA, Inc.

PO Box 5801

San Mateo, CA 94402

Telephone: 650 572 1200

http://www.sdisw.com/lpd/prices.htm
http://www.sdisw.com/license.htm
http://sdisw.com/maintenance.htm
http://sdisw.com/maintenance.htm
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1.9 Support/Questions/Suggestions

The best way to contact SDI about support or with questions or suggestions is to send an e-mail message to 
support@sdisw.com. You may also write or call:

SDI USA, Inc.
PO Box HM 5801
San Mateo, CA 94402

650 572 1200

Please include the following information with any support request:
 

1. What version of Windows you are running.

 2. What version of SDI LPD you are running. Select About SDI LPD... from the Help menu to
get the SDI LPD version number and build date.

3. Can the problem be recreated? If so, how?

4. Include the full text of any dialog or message boxes that appear when the problem occurs.

5. Your telephone number and e-mail address.

SDI welcomes any questions about SDI LPD and we will do our best to answer those questions in a timely
manner. 

SDI would also like your input about possible enhancements to SDI LPD. We are interested in anything that will
make SDI LPD easier to use, more efficient or more effective. Many of the product's features came from
suggestions from early users of the product.

We are also looking for new product ideas and if you have an idea for a Windows product that you want
developed please let us know. 

1.10 Version History

Changes to Version 3.5, April, 2011

Enhancements and Corrections:

 

Abend Corrected an abend that could occur if a default printer was not
defined.

Changes to Version 3.4, March, 2010

There have been no changes or corrections made in this release.

Changes to Version 3.3, April, 2008

Enhancements and Corrections:

 

Printer Initialization Add the ability to specify printer initialization and termination strings
if the "Send raw data to printer" option is on.

Convert LF to CR/LF The "Convert LF to CR/LF" printer option is now supported when the
"Send raw data to printer" option is on.

mailto:support@sdisw.com


SDI LPD User Guide6

SDI LPD Copyright © 2002-2025 by SDI USA, Inc. All rights reserved. 

Print to Disk File Added the $COMPUTERNAME, $DATE and $TIME variables to the
output disk file name variable substitution. Support for
environmental variables was also added. 

Changes to Version 3.2, August, 2008

Enhancements and Corrections:

 

Print to Disk File Added the ability to include variable names in the output disk file
name.

Changes to Version 3.1, April, 2007

Enhancements and Corrections:

 

Windows Vista: Improved compatibility with Windows Vista.

Changes to Version 3.0, November, 2006

Enhancements and Corrections:

 

Space in filename: If the file name in a "Control File" or "Data File" contained a space 
SDI LPD was not printing it.

Changes to Version 2.5, January, 2006

Enhancements and Corrections:

 

Print Nulls: Added the "Print nulls" option to the Print Queue Setup dialog. This
option prints nulls as spaces.

Print to Disk: Added the "Disk File: by username and job number" selection to the
Printer options in the Print Queue Setup dialog.

Setup Menu: The number of print queues that can be displayed in the Setup, Print
Queues menu selection was increased from 21 to 101. to the Printer
options in the Print Queue Setup dialog.

Changes to Version 2.4, April, 2004

Enhancements and Corrections:

 

Raster Files: Added support for printing raster files.

Default Queue: It is now possible to define a default queue. Any jobs with an
unknown queue name are routed to the default queue.

Refresh: Added the Refresh command to the View menu.

SDI LPD Initial Release 2.3, July 2002
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2 How to...

2.1 Getting Started

1. Click on the Start button, select All Programs, select SDI LPD, double-click on SDI LPD.

2. Create a print queue to receive your print files. 

3. You may minimize SDI LPD to the system tray by opening the Setup menu and selecting Run in
System Tray. To maximize the SDI LPD window, right click on the System Tray icon and click on the
Restore command in the pop-up menu. 

4. If you want SDI LPD to start every time you reload Windows, you should add a shortcut to sdilpd.exe
to your Windows Startup Folder (Start, Settings, Taskbar & Start Menu..., Start Menu Programs tab,
Add... button, Browse... button, navigate to sdilpd.exe, Open button).  

2.2 Sending Print Files to LPD

Once SDI LPD is running, it can receive print jobs from remote computers via TCP/IP. Any computer on the
network (intranet or Internet) that supports LPR can send the print jobs to SDI LPD. See the following topics for
information on printing to SDI LPD in your environment. 

Sending Microsoft Windows Print Files to LPD
Sending AS/400 Print Files to LPD
Sending VSE/ESA Print Files to LPD
Sending VM/ESA Print Files to LPD
Sending z/OS TSO Print Files to LPD

2.3 Sending Microsoft Windows Print Files to LPD

This section outlines how to send print files from Microsoft Windows to SDI LPD. Additional information about
LPR on Windows can be found in the Microsoft Windows Help file.

Windows, 7, 8.10 and 11 - The LPR Port Monitor component must be installed or the LPR command is not
available. 

Send a Text File to SDI LPD

Use the following steps to send a text file (*.txt) from Windows to SDI LPD. After the connection is working, you
may want to set up an LPR port that automatically routes prints jobs to SDI LPD. Those steps are described in
the next section of this topic.

 

1. Create a print queue in LPD. This example uses a print queue name of winq. 

2. Use notepad to create a text file (c:\test.txt) with a few lines of text in it.

3. Open a Windows command prompt and enter the following command.

lpr -S 127.0.0.1 -P winq c:\test.txt
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Where:
 

lpr is the Microsoft Windows command 
 

-S 127.0.0.1 127.0.01. is the host name or IP address.. This example uses 127.0.0.1, a
loopback IP address which sends the data to SDI LPD on the same PC
where the command was issued. Replace 127.0.0.1 with another server
name or IP address to send the print to another location. 

 

-P winq winq is the printer queue name defined in SDI LPD. 

c:\test.txt c:\test.txt is the name of the file to send to SDI LPD for printing.

4. If you are unable to print, use the Windows ping command to verify the connection with the
computer running SDI LPD. For example:

 PING 127.0.0.1
 

Create a Windows LPR Port for LPD Printing (Windows 7, 8, 10 and 11)
 

This section outlines how to create an LPR printer port on Windows 7, 8, 10 or 11. All print files spooled to this
port are routed via TCP/IP to SDI LPD on another Windows PC.

1. Create a SDI LPD printer queue. See Create a print queue in LPD for more information. The print
queue you create must specify the "Send raw data to printer" option.

2. Start the "Add Printer Wizard". (Start, Control Panel, Hardware and Sound, Printers Add a Printer)

3. In the Choose a local or network printer dialog, select "Add a local printer".

4. In the Choose a printer port dialog, select the "Create a new port" radio button and in the "Type of
port" edit box choose LPR Port. Click the Next button.

5. In the "Add LPR compatible printer" dialog box, fill in the host name or IP address of the computer
running SDI LPD and the name of the SDI LPD printer queue. Click the OK button.

6. In the Install the printer driver dialog, select the printer driver for the printer assigned to the SDI
LPD printer queue. Click  Next >.

7. In the Typed a printer name dialog, select a name for the LPR printer. (To avoid confusing the LPR
printer with a standard printer, specify LPR or LPD in the printer name.) Click  Next >.

8. In the You've successfully added printer_name dialog, Click the Print  a test page button. If
everything is working correctly, a test page should be printed. Click the Finish button.

9. You may now print jobs to SDI LPD by selecting the newly created printer port from any Windows
program.



How to... 9

SDI LPD Copyright © 2002-2025 by SDI USA, Inc. All rights reserved. 

Create a Windows LPR Port for LPD Printing (Windows 2000 and XP)
 

This section outlines how to create an LPR printer port on Windows 2000 0r XP. All print files spooled to this port
are routed via TCP/IP to SDI LPD on another Windows PC.

This facility is available in Windows 2000 and Windows XP. "Print Services for Unix" must be installed or LPR
ports are not available. See the step-by-step instructions for creating an LPR port below. For more information,
review the Windows online help file. 

(Windows 2000: Start, Help, Index, LPR, ports)

(Windows XP: Start, Help and Support, Search for LPR) 

1. Create a SDI LPD printer queue. See Create a print queue in LPD for more information. The print
queue you create must specify the "Send raw data to printer" option.

2. Start the "Add Printer Wizard". 

Windows XP: Start, Control Panel, Printers and Faxes, Add a Printer 

Windows 2000
: 

Start, Settings, Printers, Add Printer

3. In the Add Printer Wizard dialog "Welcome..." screen,  Click  Next >.

4. In the Add Printer Wizard dialog "Local or Network Printer" screen, select the following radio button
and Click  Next >.

Windows XP: "Local printer attached to this computer" 

Windows
2000: 

"Local printer"

5. In the Add Printer Wizard dialog "Select a Printer Port" screen, select the "Create New Port" radio
button. Select "LPR port" from the "Type of port" drop-down list box. Click  Next >. 

Note: If the "LPR port" selection is not available, "Print Services for Unix" must be installed. 

Windows XP: Start, Control Panel, Add/Remove Programs, Add/Remove Windows
Components, Other Network File and Print Services. 

Windows 2000
: 

Start, Settings, Control Panel, Add/Remove Programs, Add/Remove
Windows Components, Other Network File and Print Services. 

6. In the "Add LPR compatible printer" dialog box, fill in the host name or IP address of the computer
running SDI LPD and the name of the SDI LPD printer queue. Click the OK button.

7. In the Add Printer Wizard dialog "Install Printer Software" screen, select the printer driver for the
printer assigned to the SDI LPD printer queue. Click  Next >.

8. In the Add Printer Wizard dialog "Name Your Printer" screen, select a name for the LPR printer.
(To avoid confusing the LPR printer with a standard printer, specify LPR or LPD in the printer name.)
Click  Next >.

9.  In the Add Printer Wizard dialog "Printer sharing" screen, select the "Do not share this printer"
radio button.  Click  Next >.

10.  In the Add Printer Wizard dialog "Print Test Page" screen, select the "Yes" radio button. Click 
Next >. If everything is working correctly, a test page should be printed.

11.  In the Add Printer Wizard dialog "Completing the Add Printer Wizard" screen, click the Finish
button.

12.  You may now print jobs to SDI LPD by selecting the newly created printer port from any Windows
program.
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2.4 Sending AS/400 Print Files to LPD

This section outlines how to send print files from an AS/400 to SDI LPD. Additional information about LPR on the
AS/400 is in the following IBM manuals:

OS/400 TCP/IP Fastpath Setup (SC41-5430)
OS/400 TCP/IP Configuration and Reference (SC41-5420)

 

Send a Spool File to SDI LPD

Use the following steps to send an existing spool file from the AS/400 to SDI LPD. After the connection is
working, you may want to set up an AS/400 print queue that automatically routes prints jobs to SDI LPD. Those
steps are described in the next section of this topic.  

 

1. Create an SCS (SNA character String) print queue in LPD. This LPR example sends SCS formatted
print files, so check the SNA Character String (SCS) printer check box when the queue is created.
This example also uses a print queue name of AS400.

 

2. On the AS/400, locate the spool file you want to send to SDI LPD. Issue the Work with Spooled Files
(WRKSPLF) command to see your spooled files. Press PF10 to display the job information for the
spooled files. Make a note of the file, job, user name, job number and spool file number.

 

3. Issue the Send TCP/IP Spooled File (SNDTCPSPLF) command. For example:

SNDTCPSPLF RMTSYS(*INTNETADR) INTNETADR('1.2.3.4')
RMTPRTQ('AS400') FILE(FILE3)
JOB(000480/STEVE/TESTJOB)
SPLNBR(2) DESTTYPE(*OTHER) TRANSFORM(*NO)

 

Where:
 

RMTSYS(*INTNETADR) *INTNETADR indicates the IP address of the computer running SDI LPD is
specified in the INTNETADR parameter. 

INTNETADR('1.2.3.4') 1.2.3.4 is the IP address of the computer running SDI LPD.

RMTPRTQ('AS400') AS400 is the SDI LPD print queue set up for receiving jobs from the AS/400.

FILE(FILE3) FILE3 is the spool file name.

JOB(000480/STEVE/TESTJOB) 480 is the job number. STEVE is the user name. TESTJOB is the
job name.

SPLNBR(2) 2 is the spool file number.

DESTTYPE(*OTHER) *OTHER indicates the remote system is not an AS/400.

TRANSFORM(*NO) *NO indicates the SCS data will not be translated to ASCII.

4. If you are unable to print, use the AS/400 PING command to verify the connection with the computer
running SDI LPD. For example:

 PING RMTSYS(*INTNETADR) INTNETADR('1.2.3.4')
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Create an AS/400 Printer Queue for LPD Printing

 This section outlines how to create a printer queue on the AS/400 specifically for LPD printing. All print files
spooled to this queue are routed to SDI LPD.

 

Use the Create Output Queue (CRTOUTQ) command to create a printer queue on the AS/400. For example,
create a AS/400 printer queue named "PRT2LPD" that routes print jobs to SDI LPD queue "AS400" at IP
address "1.2.3.4".

 

CRTOUTQ OUTQ(PRT2LPD) RMTSYS(*INTNETADR)
INTNETADR('1.2.3.4') AUTOSTRWTR(1)
RMTPRTQ('AS400') CNNTYPE(*IP) 
DESTTYPE(*OTHER) TRANSFORM(*NO)
 

Where:
 

OUTQ(PRT2LPD) PRT2LPD is the OS/400 output queue name.

RMTSYS(*INTNETADR) *INTNETADR indicates the IP address of the computer running SDI LPD is
specified in the INTNETADR parameter.

INTNETADR('1.2.3.4') 1.2.3.4 is the IP address of the computer running SDI LPD.

RMTPRTQ('AS400') AS400 is the print queue name defined in SDI LPD. See Configure an SCS
Print Queue in SDI LPD at the beginning of this chapter.

AUTOSTRWTR(1) 1 autostarts one writer for the queue.

CNNTYPE(*IP) *IP indicates a TCP/IP connection. 

DESTTYPE(*OTHER) *OTHER indicates the remote system is not an AS/400.

TRANSFORM(*NO) *NO indicates the SCS data will not be translated to ASCII.

2.5 Sending VSE/ESA Print Files to LPD

This section outlines how to send print files from VSE/ESA to SDI LPD. Additional information about LPR on
VSE/ESA is in the following manuals:

 

TCP/IP for VSE User's Guide 
TCP/IP for VSE Programmer's Reference 

Configure an SDI LPD Print Queue for VSE/ESA Print Files 

Before you can send print files from VSE/ESA LPR to SDI LPD, you must create a print queue in LPD. 

There are 4 methods of sending print jobs from VSE to LPD:

1. Using the LPR CICS transaction.
 

2. Using the Automatic LPR client (AUTOLPR) facility to send output from a job to LPD.
 

3. Using the LPR batch client to print a file and send it to LPD.
 

4. From an application program using the sockets interface. 
 

The first 3 methods are discussed in detail in the TCP/IP for VSE User's Guide. The last method is discussed in
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the TCP/IP for VSE Programmer's Reference.

2.6 Sending VM/ESA Print Files to LPD

This section outlines how to send print files from VM/ESA to SDI LPD. Additional information about LPR on
VM/ESA is in the following manuals:

 
VM RSCS Planning and Installation (SH24-5219)
VM RSCS Operation and Use (SH24-5220) 
 

1. Create a SDI LPD Print Queue for VM/ESA print files 

Before you can send print files from VM/ESA LPR to SDI LPD you must create a print queue in LPD. This
example uses a print queue name of VMPRTQ.

2. Configure an LPR link in RSCSTCP CONFIG

The following is an example of the LINKDEFINE and PARM statements required for an LPR link. These
statements must be added to RSCSTCP CONFIG on TCPMAINT 198. 

Note: RSCS must be shutdown and restarted for the changes to RSCSTCP CONFIG to take affect.
 

LINKDEFINE LPRONE TYPE LPR AST CLASS *
PARM LPRONE EXIT=LPRXONE HOST=1.2.3.4 PRINTER=VMPRTQ

 

Where:
 

LINKDEFINE LPRONE LPRONE is the name of the link. This name is specified on the CMS TAG
command to indicate where to send a spool file. 

 

TYPE LPR indicates this is an LPR link.
 

AST indicates the link will be autostarted when a file is sent to it.
 

CLASS * indicates all file classes may be processed by the link.
 

PARM LPRONE Parameter statement for the LPRONE link.
 

EXIT=LPRXONE specifies the exit module for this link. LPRXONE is the default exit module
provided by IBM for non-postscript printers

 

HOST=1.2.3.4 1.2.3.4 is the IP address of the computer running SDI LPD.
 

PRINTER=VMPRTQ VMPRTQ is the SDI LPD print queue set up for receiving jobs from VM/ESA.

3. Print a File 

Logon to a CMS user and enter the following commands to print the file PROFILE EXEC to the VMPRTQ print
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queue in SDI LPD.
 

spool prt rscs
tag dev prt lprone
print profile exec

 

Where:
 

spool prt rscs Spools print files to the RSCS reader
tag dev prt lprone Adds a tag to all files in the print queue indicating they are to be routed to

printer link "lprone". 
print profile exec Prints the profile exec file. This file will be spooled to the RSCS reader and

RSCS will route it in LPR format to the IP address in the LPRONE link.

2.7 Sending z/OS TSO Print Files to LPD

This section outlines how to send print files from z/OS, OS/390 or MVS TSO to SDI LPD. Additional information
about LPR on z/OS is in the following manuals:

 

OS/390 eNetwork Communications Server: IP User's Guide, GC31-8514
CS for OS/390 TCP/IP Implementation: MVS Applications, SG24-5229-01
 

1. Create an SDI LPD Print Queue for z/OS print files 

Before you can send print files from TSO LPR to SDI LPD you must create a print queue in LPD. This example
uses a print queue name of ZOSPRTQ.

2. Print a File 

 Logon to TSO and enter the following commands to print the file sys1.tcpparms(lpddata) to the ZOSPRTQ print
queue in SDI LPD. In this example, the IP address of the PC running SDI LPD is 1.2.3.4
 

TSO LPRSET ZOSPRTQ@1.2.3.4
TSO LPR 'SYS1.TCPPARMS(LPDDATA)'

 

Where:
 

TSO LPRSET ZOSPRTQ@1.2.3.4 Sets your default TCP/IP printer destination. ZOSPRTQ is the SDI
LPD printer queue name and 1.2.3.4 is the IP address of the PC running SDI
LPD.

 

TSO LPR 'SYS1.TCPPARMS(LPDDATA)' Prints data set SYS1.TCPPARMS(LPDDATA) to the
default TCP/IP printer.

2.8 Sending Linux Print Files to LPD

This section outlines how to send print files from Linux to SDI LPD. Additional information about printer
configuration and LPR may be found in the Linux help files. 

1. Create an SDI LPD Print Queue for Linux print files 

Before you can send print files from Linux to SDI LPD you must create a print queue in LPD.  This example
assumes SDI LPD is running on a Windows PC with an IP address of 192.168.1.2 and a print queue name of
LINUXPRTQ.
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2. Configure a printer in Linux 

The following example was created using Red Hat Linux. The commands and statements may vary slightly for
other flavors of Linux.

 

A. Open printconf (Gnome: Main, Programs, System, Printer Configuration)
 

B. Click the New button on the printconf tool bar. Fill in the Add a New Print Queue wizard prompts. For
example:

 

Queue Name = SDILPD
Queue Type = Unix Printer  (LPD)
Server = 192.168.1.2 (IP address or host name of Windows PC running LPD)
Queue = LINUXPRTQ (This must match the queue defined in SDI LPD)
Print Driver = Text Only Printer
Save the changes. (File, Save Changes) 

 

C. The above example creates this entry in /etc/printcap

SDILPD:\
         :ml=0:\
         :mx=0:\
         :sd=/var/spool/lpd/SDILPD:\
         :af=/var/spool/lpd/SDILPD/SDILPD.acct:\
         :sh:\
         :rm=192.168.1.2:\
         :rp=LINUXPRTQ:\
         :lpd_bounce=true:\
         :if=/usr/share/printconf/util/mf_wrapper:

 

D. Print a test file using the LPR command. This command will print the /etc/hosts file.
 

lpr -PSDIPD /etc/hosts

3 Administrators Guide

3.1 Changing the Listening Port

SDI LPD listens for print jobs on port 515 by default. Port 515 is the standard LPD listening port. If your system
uses a non-standard port, you can change the SDI LPD listening port by adding the following DWORD registry
entry and specifying the desired port number.

HKEY_CURRENT_USER\Software\SDI\SDI LPD\Settings\Port

Step by Step Instructions:

1. Run regedit.exe to start the Registry Editor. (Start, Run..., regedit.exe)

2. Navigate to HKEY_CURRENT_USER\Software\SDI\SDI LPD\Settings\Port

3. Right click on Settings to display the context menu. Hover over New and select DWORD Value.

4. Change the name of the new registry entry from "New Value #1" to "Port".

5. Right click on "Port" and select Modify. 

6. Enter the new listening port number in the "Value data:" edit box.

7. Close the Registry Editor.  (Registry, Close)



Administrators Guide 15

SDI LPD Copyright © 2002-2025 by SDI USA, Inc. All rights reserved. 

3.2 Global Registry Settings

The following registry entries are read from HKEY_LOCAL_MACHINE if they are not found in
HKEY_CURRENT_USER. This allows you to set global values for all users on a PC by moving these entries
from HKEY_CURRENT_USER to HKEY_LOCAL_MACHINE.

HKEY_CURRENT_USER\Software\SDI\SDI LPD\Settings\LicenseDataPath

(String value)

HKEY_CURRENT_USER\Software\SDI\SDI LPD\Settings\LicenseCodePath

(String value)

3.3 Running LPD as a System Service

SDI LPD is not designed to be run as a system service. However, Microsoft provides two utility programs that will
allow you to run SDI LPD as a system service on Windows 2000, Server 2003, Server 2008, XP, and 7

The programs are:
 

srvany.exe srvany.exe allows standard applications to run as a system service. The srvany.exe runs as
the system service and acts a wrapper for the standard application.

instsrv.exe instsrv.exe is required to install srvany.exe as a service.

Downloading Srvany.exe and Instsrv.exe

Srvany.exe and instsrv.exe are included in the Windows resource kits for Windows 2000, XP and Server 2003. A
free download of the Windows Server 2003 Resource kit is available at the following location.

Location Description

Windows Server 2003 Resource Kit Tools The Window Server 2003 Resource Kit will only install
on Windows Server 2003 and Windows XP. However
the srvany.exe and instsrv.exe files contained in the kit
will run on Windows 2000, XP and 2003 

If the above link does not work for you, try an Internet search for srvany.exe and/or instsrv.exe.

Installing LPD as a System Service (Logon as a System Account)

Use the following steps to install SDI LPD as a system service using instsrv.exe and srvany.exe. In these
instructions, SDI LPD will refer to SDI LPD running as a standard application. SDILPD (no space) will refer to
SDI LPD running as a service.

The steps in this example assume the following:
 

· Srvany.exe and instsrv.exe have been copied to c:\rktools.
· SDI LPD is installed in c:\program files\sdi\TN3270 Plus\. 
 

You will have to modify these instructions if you are using different directories.
 

1. Install an instance of srvany.exe as a system service wrapper for SDI LPD. Open a command prompt and
enter:
c:\rktools\instsrv "SDILPD" "c:\rktools\srvany.exe"

 

http://www.microsoft.com/downloads/details.aspx?familyid=9d467a69-57ff-4ae7-96ee-b18c4790cffd&displaylang=en
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2. Go to the Windows Services Management Console and configure the "SDILPD" service created in step 1.
(Windows 7, 8: Start, Control Panel, System and Maintenance, Administrative Tools, Services)
(Windows XP: Start, Control Panel, Administrative Tools, Services)
(Windows 2000: Start, Settings, Control Panel, Administrative Tools, Services) 
 

Right click on the SDILPD item in the services list and then select Properties from the context menu.
 

General tab: Set "Startup type" = Automatic (Set to "Manual" for manual startup)
Log On tab:  Select the "Local System account" radio button. 

Also check the "Allow Service to Interact with the desktop" check box. 
Note: In order for the service to interact with the desktop in Windows Vista
and above, the Windows Interactive Service Detection service must be
started. (Control Panel, System and Maintenance, Administrative Tools,
Services, Interactive Service Detection) 

 
 

3. Add the required registry entries. Run regedit.exe and navigate to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SDILPD and add a "Parameters"
key. Under the Parameters key add the following string values: 

 

Name Type Value

Application REG_SZ 

AppDirectory REG_SZ

For example:
 

4. Go to the Windows Services Management Console and start the "SDILPD" service.
 

(Windows 7, 8: Start, Control Panel, System and Maintenance, Administrative Tools, Services
(Windows XP: Start, Control Panel, Administrative Tools, Services)
(Windows 2000: Start, Settings, Control Panel, Administrative Tools, Services)
 

Right click on the SDILPD item in the services list and then select Start from the context menu.

Installing LPD as a System Service (Log On as a User Account)

Install SDI LPD on a user account and set up your print queues and test that everything is working properly with
SDI LPD running as a standard application. Once the setup is complete, exit SDI LPD. 

Now you can set up the SDILPD service to log on an a User Account instead of a System Account. This setup
will allow you to use the SDI LPD queues that you set up when SDI LPD was running as a standard application
on a User Account.

Follows the same steps provided in the example above. When you get to step 2, set the following properties:

General tab: Set "Startup type" = Automatic (Set to "Manual" for manual startup)
Log On tab:  Select the "This account" radio button. In the "This account" edit box specify

the Window's user account you used to setup the SDI LPD print queues. Fill
in the user account password.
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Complete the rest of the steps in the example above.

Test the LPD service. It should work the same way a SDI LPD running as a standard application. To add, delete
or edit queues, log on to the user account you specified in the "This account" edit box and start SDI LPD as a
standard application. You will get the "Port 515 is in use by another application" message (because the
SDILPD service is running and using port 515). Just click OK and you can add, delete or edit your queues.
These changes will immediately be recognized by the SDILPD service.

4 Menus

4.1 File Menu

4.1.1 Command Summary

The File menu contains the following commands:

Print... Print a job from the print queue.

Delete Delete a job from the print queue.

Close Closes the SDI LPD window.

4.1.2 Print

Print a job from the print queue. 

Shortcuts:

Standard Toolbar:

Keys: Ctrl+P

4.1.3 Close

Close the SDI LPD window.
 

When the Run in System Tray option is off, the application is closed. When the Run in System Tray option is on,
the SDI LPD window is closed, but the application remains running in the system tray. 

Shortcuts:

None

4.1.4 Delete

Delete a job from the print queue. 

Shortcuts:
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Standard Toolbar

Keys: Del

4.2 Edit Menu

4.2.1 Command Summary

The Edit menu contains the following commands:

Select All Select all print jobs.

Deselect Deselect selected print jobs.

4.2.2 Select All

Select all print jobs currently in the print queue.

4.2.3 Deselect

Deselect selected print jobs.

4.3 View Menu

4.3.1 Command Summary

The View menu contains the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Log File View the contents of the log file.

Refresh Refresh the print jobs list.

Control File View the contents of  the control file.

Data File View the contents of the data file

4.3.2 Toolbar

Display or Hide the Toolbar. A check mark appears prior to the menu item when the toolbar is displayed.

4.3.3 Status Bar

Display or hide the Status Bar. The Status Bar shows messages and information that describe the state of the
application. A check mark appears prior to the menu item when the Status Bar is displayed.
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4.3.4 Refresh

Refresh the print jobs list in the SDI LPD window. 

Use this command when print queues are shared (on a network drive) by multiple PCs running SDI LPD. For
example, assume the following:
 

· SDI LPD is running on PC A and PC B.
· PC A and B share a print queue on network drive H. 
· The shared print queue name is MainframePrintQueue. 
· MainframePrintQueue is setup to hold print jobs rather than printing them. 
 

When SDI LPD on PC A receives a print job into MainframePrintQueue, the job list on PC A is updated but the
job list on PC B is not updated. Issuing the Refresh command on PC B causes SDI LPD to rescan all the print
queues and update the jobs list. After the refresh, the jobs list on PC B will show the print job received into the
MainframePrintQueue by PC A.
 

Shortcuts:

Standard Toolbar:  

4.3.5 Log File

View the contents of the log file. The log file is a date-stamped file containing a record of all print jobs received.

4.3.6 Control File

View the contents of the control file for the selected print job. Each print job is composed of two files, the control
file and data file. The control file contains print control information and the data file contains the text to be
printed.

4.3.7 Data File

View the contents of the data file for the selected print job. Each print job is composed of two files the control file
and data file. The control file contains print control information and the data file contains the text to be printed.

4.4 Setup Menu

4.4.1 Setup Menu Command Summary

The Setup menu contains the following commands:

Print Queues Tailor your print queues

Logging... Setup the SDI LPD Log files.

Run in System Tray... Toggle the system tray option on or off.

Trace Socket... Turns TCP/IP socket tracing on or off.

4.4.2 Print Queues command (Setup menu)

Tailor your print queues. A secondary menu allows you to select an existing print queue or New Queue…
Selecting an existing queue displays the Print Queue Setup dialog box so you can modify the print queue
settings. Selecting New Queue…, displays the Save As dialog box. Enter the print queue name in the Save As
dialog box and click OK. The Print Queue Setup dialog box appears so that you can tailor your new print queue.
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4.4.3 Logging command (Setup menu)

Setup the SDI LPD log files. This command displays the Logging Setup dialog. Use this dialog to specify a log
file name, manage your log files and activate or deactivate logging. The log file contains information about  SDI
LPD print job processing.

4.4.4 Run in System Tray (Setup menu)

Toggle the application to or from the system tray. This menu item contains a check mark when the Run in
System Tray option is active.

4.4.5 Trace Socket command (Setup menu)

Use this diagnostic command to trace socket activity. Normally you will not use this command unless requested
to do so by SDI technical support. 

To run a trace, perform the following steps:

1. Start SDI LPD.

2. Start the trace. 

a) Open the Setup menu and click on Trace Socket...

b) In the Select Trace File Name dialog box, specify a name for the trace file and note the folder
that it is in. 

3.  Receive the failing print job.

4. Stop the trace. Open the Setup menu and click on Trace Socket...

5. E-mail the trace file and a description of the problem to trace@sdisw.com.

4.5 Help Menu

4.5.1 Command Summary

The Help menu contains the following commands, which provide you assistance with this application: 

Help Topics Displays the table of contents for the help file. This command also gives
you access to the help index and the help find function.

About SDI LPD... Displays the version number and build date of this application.

4.5.2 Help Topics (Help menu)

Use this command to display the contents of the SDI LPD Help file.  From the opening screen, you can jump to
step-by-step instructions for using SDI LPD and various types of reference information.

4.5.3 About (Help menu)

Use this command to display the copyright notice, version number and build date of your copy of SDI LPD.

mailto:trace@sdisw.com
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4.6 System Tray Menu

4.6.1 Command Summary

The System Tray menu is displayed by right-clicking the SDI LPD icon in the system tray. SDI LPD runs in the
system tray when the Run in System Tray option is on (Setup, Run in System Tray)

 

Restore Restore the SDI LPD window.
 

About Display the About dialog box. 
 

Exit Exit SDI LPD.

4.6.2 Restore command (System Tray menu)

Use this command to restore the SDI LPD window after it has been minimized to the system tray icon (Setup,
Run in System Tray). 

4.6.3 About command (System Tray menu)

Use this command to display the copyright notice, version number and build date of your copy of SDI LPD.

4.6.4 Exit command (System Tray menu)

Use this command to exit SDI LPD.

5 Tool and Status Bars

5.1 Toolbar

The standard toolbar is displayed across the top of the application window, below the menu bar. 

To hide or display the standard toolbar: Choose Toolbar from the View.
 

Click To...
 

Print the selected job(s) from the print queue.

Delete the selected job(s) from the print queue.

Refresh the print jobs list in the SDI LPD window.

Display the "About SDI LPD dialog box.

5.2 Status Bar

The status bar is displayed at the bottom of the application window.  To display or hide the status bar, use the S
tatus Bar command in the View menu.  
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6 FAQ (Frequently Asked Questions)

This section contains frequently asked questions and answers. 

6.1 FAQ (Frequently Asked Questions).

Most Common Questions

Can SDI LPD run as a system service?

Port 515 is in use by another application

License Code Questions

The license code is not valid for this release. 

The 'License code' field is incorrect.

The 'Licensed to' field is incorrect. 

Most Common Questions and Answers

Can SDI LPD run as a system service?

See Running LPD as a System Service. 

(Return to top)

Port 515 is in use by another application

You will receive this message if you start a second instance of SDI LPD because the first instance is already
using port 515.

If the Windows LPD Print Service is active you will receive this message. The Windows LPD Print Service uses
port 515. You must turn off this service to release port 515. To turn off the service:

Windows 7, 8, 10 and 11 Control Panel, Programs and Features, Turn Windows features on or off, Expand
Print and Document Services, Uncheck LPD Print Service

Windows NT, 2000 or XP Control Panel, Add/Removed Programs, Add/Remove Windows Components,
Other Network File and Print  Services, Details, Uncheck Print Services for Unix

(Return to top)

License Code Questions and Answers

The license code is not valid for this release.

The license code you entered is for an older release of SDI LPD. The license code is generated for a specific
release and will not function with newer releases of TN3270 Plus.

The product release level is three digits separated by periods, for example, 3.4.0. The license code only checks
the first two digits, so a license code created for 3.4.0 will work with releases 3.4.0 through 3.4.9. In addition,
license codes for release 3.3 and above will work with the next higher release. For example, a release 3.4
license code will also work with release 3.5 (3.5.0 - 3.5.9). However, if you try to use a release 3.4 license code
with release 3.6.0 or higher you will get the above error message.

If you have purchased a maintenance and support subscription, updates are free. Send an e-mail to
sales@sdisw.com with your current "licensed to" name and the new release level and you will be e-mailed a
license code for the new release.

If you do not have a maintenance and support subscription, you will need to subscribe to our maintenance and
support plan in order to receive the new product release.
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(Return to top)

The 'License code' field is incorrect.

The "License code" field contains a typographical error. Make sure that all the characters are correct.

(Return to top)

The 'Licensed to' field is incorrect.

The name in the "Licensed to" name does not match the name encrypted into the license code.

1. The "Licensed to" name is incorrect or contains a typographical error. 

2. Make sure the "Licensed to" name has the correct number of spaces. 

3. The "Licensed to" name and license code are issued in pairs. The "Licensed to" name must correspond to the
license code you entered. 

(Return to top)

7 Glossary

command prompt

control file

daemon

domain name

fixed-pitch font

IP address

LPD

LPR

ping

windows folder



SDI LPD User Guide24

SDI LPD Copyright © 2002-2025 by SDI USA, Inc. All rights reserved. 

Index
- A -
About (Help menu)     20

About command (System Tray menu)     21

AS/400     10

AUTOLPR     11

- B -
build date     20

- C -
CICS     11

CIF files     2

Close command (File menu)     17

Control File command (View menu)     19

copyright notice     20

CRTOUTQ     10

- D -
Data File command (View menu)     19

DataPath     15

Delete command (File menu)     17

Deselect command (Edit menu)     18

Diagnostics    

Trace Socket command     20

DVI files     2

- E -
Edit menu     18

command summary     18

Deselect command     18

Edit menu     18

Select All command     18

Exit command (System Tray menu) System Tray
menu    

Exit command     21

System Tray menu     21

- F -
fee     2

File menu     17

Close command     17

command summary     17

Delete command     17

Print command     17

- G -
getting started     7

global registry settings     15

- H -
Help menu     20

About command     20

command summary     20

Help Topics command     20

Help Topics (Help menu)     20

HKEY_LOCAL_MACHINE     15

- I -
icon     21

instsrv.exe     15

Introduction     1

- L -
license agreement     2

license fee     2

LicenseCodePath     15

Linux     13

listening port     14

log file     19

Log File command (View menu)     19

Logging (Setup menu)     20

LPD     1, 7

getting started     7

introduction     1

LPD     20

restrictions     2

run in system tray     20



Index 25

SDI LPD Copyright © 2002-2025 by SDI USA, Inc. All rights reserved. 

LPD     1, 7

sending print jobs to     7

LPR     7, 10, 11, 12, 13

LPSERVE     12

- N -
network     19

- O -
order form     4

ordering     2

OS/390     13

- P -
Plot CIF files     2

port     14

Postscript files     2

price     2

Print command (File menu)     17

print queue     19

Print Queues command (Setup menu)     19

printcap     13

printconf     13

product price     2

- Q -
questions     5

- R -
Raster files     2

Refresh     19

Refresh command (View menu)     19

registering     2

registration form     4

Restore command (System Tray menu)     21

RFC     1

RSCS     12

Run in System Tray (Setup menu)     20

- S -
Select All command (Edit menu)     18

sending print jobs     7, 11, 12, 13

LPR port     7

SCS     10

Setup menu     19, 20

command summary     19

Logging     20

Print Queues command     19

Run in System Tray     20

Setup menu     20

Trace Socket command     20

SNDTCPSPLF     10

srvany.exe     15

status bar     21

Status Bar command (View menu)     18

suggestions     5

support     5

system requirements     2

system service     15

system tray     7, 17, 21

System Tray menu     21

About command     21

Restore command     21

- T -
time stamp     19

Toolbar command (View menu)     18

toolbars     21

standard toolbar     21

Trace Socket command (Setup menu)     20

tray icon     21

TSO     13

- V -
version history     5

version number     20

View menu     18, 19

command summary     18

Control File command     19

Data File command     19

Log File command     19

Refresh command     19



SDI LPD User Guide26

SDI LPD Copyright © 2002-2025 by SDI USA, Inc. All rights reserved. 

View menu     18, 19

Status Bar command     18

Toolbar command     18

VM/ESA     12

VSE/ESA     11

- W -
warranty     2

Windows 3.1x lpd     2

WRKSPLF     10

- Z -
z/OS     13



Back Cover


	Overview
	Introduction
	Features
	System Requirements
	Restrictions
	Evaluation and License Agreements
	Pricing
	Registration Instructions
	Registration Form
	Support/Questions/Suggestions
	Version History

	How to...
	Getting Started
	Sending Print Files to LPD
	Sending Microsoft Windows Print Files to LPD
	Sending AS/400 Print Files to LPD
	Sending VSE/ESA Print Files to LPD
	Sending VM/ESA Print Files to LPD
	Sending z/OS TSO Print Files to LPD
	Sending Linux Print Files to LPD

	Administrators Guide
	Changing the Listening Port
	Global Registry Settings
	Running LPD as a System Service

	Menus
	File Menu
	Command Summary
	Print
	Close
	Delete

	Edit Menu
	Command Summary
	Select All 
	Deselect

	View Menu
	Command Summary
	Toolbar
	Status Bar
	Refresh
	Log File
	Control File
	Data File

	Setup Menu
	Setup Menu Command Summary
	Print Queues command (Setup menu)
	Logging command (Setup menu)
	Run in System Tray (Setup menu)
	Trace Socket command (Setup menu)

	Help Menu
	Command Summary
	Help Topics (Help menu)
	About (Help menu)

	System Tray Menu
	Command Summary
	Restore command (System Tray menu)
	About command (System Tray menu)
	Exit command (System Tray menu)


	Tool and Status Bars
	Toolbar
	Status Bar

	FAQ (Frequently Asked Questions)
	FAQ (Frequently Asked Questions).

	Glossary

